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Introduction 

The purpose of this document is to summarise the changes in the release of SOS Connect and 
SOS Accounts V5.18.19 & V6.18.19 revision 12019.  It is aimed at those clients who are 
considering upgrading to this version, but is also an important resource of information for anyone 
who will be installing, supporting or scripting in this version.  This summary document contains the 
following information: 

• Critical bulletins relating to this release 

• Important changes to compatibility, pre-requisites or configuration 

• Changes to access rights, existing software features, scripting cards or standard scripts 

• Details of software enhancements available in this release 

• A bug fix catalogue for the fixes made in this release 

Separate documents are supplied detailing the pre-requisites, compatibility and configuration of an 
SOS system.  Where appropriate, separate documents are provided containing details of the major 
enhancements.  All documents relating to this release should be read before installing the new 
version of SOS software on any environment. 
 

Key features in this release 

In this release, support for Progress OpenEdge 10.2 has been dropped, and support for Progress 
OpenEdge 12.2 has been introduced.  This release continues to be fully supported on Progress 
OpenEdge 11, specifically OpenEdge version 11.7.  The main reason for this general update is 
ensure that SOS products continue to have a long lifespan, specifically in our use of the Progress 
OpenEdge infrastructure.  Progress have committed to long term support for OpenEdge 11.7 until 
April 2025, and for OpenEdge 12.2 until October 2028. 

As part of this general upgrade to OpenEdge 11 and 12, this release also gives users the option of 
running the SOS Accounts application (formerly known as Practice Manager) as a 64bit Windows 
desktop application in both OpenEdge versions, though for SOS clients integrating with VisualFiles 
only the 32bit SOS Accounts desktop application can be used. 

This release also contains a number of general enhancements and bug fixes, full details of which 
are provided later in this document. 
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Changes to Progress OpenEdge Compatibility 

Changes to supported OpenEdge versions 

This new software release has major changes in its compatibility with the supporting Progress 
OpenEdge infrastructure.  Whereas the previous release was compatible with OpenEdge version 10 
and version 11, this new release is no longer compatible with OpenEdge 10, but instead is 
compatible with OpenEdge 11 and 12.  SOS will no longer be building full software releases for 
OpenEdge 10, and any remaining clients still running SOS software on OpenEdge 10 (SOS 
versions starting with “4”) will require a Progress upgrade to at least OpenEdge 11 to run this and 
future releases.  As part of this upgrade in Progress infrastructure compatibility, a new version 
numbering scheme has been introduced. 

The SOS Accounts system and server-side API services are now supplied in each release as two 
parallel code packs, which are functionally identical but built for different versions of OpenEdge:  

• SOS Accounts and server-side API services version 5.18.19, compatible with Progress 

OpenEdge 11 (specifically OpenEdge 11.7 SP14 or later).  This version of SOS Accounts 

and API services will run on older versions of OpenEdge11, but while SOS makes every 

effort to support older versions of OpenEdge 11, we cannot guarantee the behaviour of the 

software on older versions of OpenEdge 11 because of known faults in the OpenEdge 

infrastructure, specifically in the areas of ODBC features and performance, and memory 

leaks in certain underlying OpenEdge functions.  The object code for SOS Accounts and 

server-side API for version 5.18.19 (OpenEdge 11.7) is supplied in a zip file called 

ProgressObjectOE11.zip 

 

• SOS Accounts and server-side API service version 6.18.19, compatible with Progress 

OpenEdge 12 (specifically OpenEdge 12.2 SP5 or later).  This version of SOS Accounts and 

API services is not certified to run on any OpenEdge 12 version earlier than V12.2.5.  The 

object code for SOS Accounts and server-side API for version 6.18.19 (OpenEdge 12.2) is 

supplied in a zip file called ProgressObjectOE12.zip 

From now on, only one version of the SOS Connect desktop application will be supplied in each 
release, and this single SOS Connect application is fully compatible with both V5.18.19 and 
V6.18.19 server-side API services.  There is no longer a separate SOS Connect version for each of 
the supported Progress OpenEdge version.  From this release on, the version number of SOS 
Connect is in the format C.18.19.   A different style of version number for SOS Connect has been 
deliberately chosen to clearly indicate that there is now no direct link between SOS Connect version 
and OpenEdge version.  SOS Connect version C.18.19 is ONLY compatible with API versions 
5.18.19 and 6.18.19: it is NOT compatible with any other server API version other than 5.18.19 and 
6.18.19.  The object code for SOS Connect is still available in both 32-bit and 64-bit versions, and is 
supplied in the release in both zip format (ConnectClient32bit.zip and ConnectClient64bit.zip), 
and in the standard TAR.GZ format for SOS Launcher (in folders Tar Files x86 and Tar Files x64). 

In OpenEdge 12, Progress have retired the “classic appserver” component, which was previously 
the standard server API platform used by SOS Connect and API integrators.  The new component 
is called “Progress Application Server For OpenEdge” (commonly abbreviated to PAS or PASOE).  
The configuration of the new PAS server component is different from “classic appserver”, but still 
runs our API business services code in the same way, and any differences in server-side 
architecture are completely transparent to SOS Connect and third-party API integration code. 
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Migrating databases from OpenEdge 11 to OpenEdge 12 

As for the previous migration process from OpenEdge 10 to 11, all SOS databases need to be 
converted from OpenEdge 11 format to OpenEdge 12 format and this will require down time.  As 
before, each of the three databases sosdb, sosbankrec (if used) and sosanaly (if used) needs to 
have the BI (before image) extent truncated first using this OpenEdge ProEnv command: 

proutil <dbname> -C truncate bi 

Once this is done, each database can be upgraded to OpenEdge 12 format using this command: 

proutil <dbname> -C conv1112 

 

Migrating from OpenEdge 11 Appserver to OpenEdge 12 PASOE 

Because of the complexity of configuring the new PASOE component, and the number of different 
ways that this component can be configured, a detailed guide for configurating a PASOE for use 
with SOS software is outside the scope of this document.  However, as part of the PASOE 
configuration for OpenEdge 12, the following still holds true: 

• The –rereadnolock and –yy 1940 parameters still need to be used in the agent start-up 

parameters list 

• All session procedure names (activate / deactivate / connect / disconnect / session start-up / 

shutdown) remain as before for classic AppServer as shown below, but note that in the web 

management console for PASOE configuration in OpenEdge 12, the order of the last two 

boxes is reversed compared to classic AppServer configuration in OpenEdge 11: 

 

 

 

SOS also recommend that a specific setting is enabled to improve the handling of unexpected 
outages/disconnections between client applications and the SOS API server running under PASOE.  
Details of this configuration option are available here: 

https://knowledgebase.progress.com/articles/Knowledge/connected-behavior-in-pas-for-openedge 

  

https://knowledgebase.progress.com/articles/Knowledge/connected-behavior-in-pas-for-openedge
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To implement this configuration change: 

• Navigate to the directory where the PASOE instance definition is stored (usually the 

OpenEdge 12 working directory name followed by the PASOE instance name) 

• Inside this folder, navigate into the conf sub-folder (e.g. 

C:\Progress12WRK\SOSLive\conf) 

• Open the file openedge.properties in a text editor, and locate the entry enclosed in square 

brackets which contains the name of the PASOE instance followed by .ROOT.APSV e.g. 

[SOSLive.ROOT.APSV] 

• Within the block of options there should be an entry called useEnhancedConnected which 

by default will be set to =0. Change the value to =1 (enabled), so that it looks as below: 

useEnhancedConnected=1 

• Save the file and restart the PASOE instance  

 

Other implications 

As part of raising the compatibility level between SOS software and Progress OpenEdge, the 
following additional points should be noted: 

• There is no longer a requirement to have the Microsoft Access dBase Driver (for DBF 

files) installed on machines running SOS Accounts, to support certain types of Crystal 

Reports.  The SOS Accounts system now handles the transport of DBF data to Crystal 

reports itself. 

• As a result of the above change, there is also no longer any need to enable “8dot3” file 

naming support on the file system where SOS Accounts and Crystal Reports are being used. 

• The SOS Accounts application and server API code are compatible with both 32bit and 64bit 

versions of Progress OpenEdge, including being able to run the SOS Accounts application 

as a 64bit Progress desktop application.  For users wanting to run SOS Accounts in 64bit 

mode, the following installers will need to be run (supplied in the PMSetup folder of the 

release, sub-folder Setup32&64Bit): 

o Crystal Reports Runtime 64bit_13_0_9.msi (required) 

o PMComponentsSetup_5.18.15_32&64Bit.msi (required) 

o vcredist_x64.exe (optional – only required if above installers fail due to missing 

prerequisites) 

• Please note that for clients using SOS software linked with VisualFiles, only the 32bit 

version of the SOS Accounts system can be used. 

• In Connect, when the Version system tray options is used, an enhanced version information 

screen is now shown, which not only shows the version of SOS Connect (beginning with C), 

but also the exact SOS software version running on the API server, together with extended 

configuration options which are in effect on the API server: 

 



Solicitors Own Software Limited (SOS)  Release Notes 

 

SOS Connect & SOS Accounts V5.18.19 & V6.18.19 Rev 12019  Page 7 of 36 

 
 

The buttons at the top-right of the screen can be used to automatically extract the 

information shown, for example when sending version information to SOS.  The top button 

(copy) will copy the information from the top three boxes (SOS Connect version, SOS 

Server version and Progress version) to the windows clipboard, allowing this basic 

information to be pasted to an email for example.  The lower button (export) can be used to 

export all of the information shown to a text file, allowing full details of system configuration 

to be sent to SOS as an email attachment. 

• Ideally, all clients taking this new release should also take a minor update to SOS Launcher 

(version 3.0.2) to ensure that the installed version of SOS Connect is displayed correctly. 
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Installation of release files 

SOS will normally insist that any new software release is installed on a customer’s own test 
environment first, so that the customer can complete their own final acceptance testing before the 
new version is installed on to a live environment.  Particular attention should be paid to the changes 
highlighted in this main document and related documents for this release.  Once you have 
confirmed to SOS Support that your testing has been completed to your satisfaction, a time slot will 
need to be booked for the upgrade of your live system.  Note that users will not be able to use the 
live system during the live upgrade. 

Functionally, versions V5.18.19 & V6.18.19 are identical.  The difference between the two versions 
is that they are built to run on different versions of the Progress OpenEdge infrastructure.  The 
following explains the infrastructure requirements for each version: 

 

SOS Software Version Recommended Progress 
OpenEdge infrastructure 

Other infrastructures certified to be 
compatible (subject to faults, 
limitations or differences in 
behaviour outside our control) 

5.18.19 and above OpenEdge 11.7 SP14 or later OpenEdge 11.6 and earlier versions of 
11.7 (all known to have faults and 
limitations in ODBC functionality, and 
also known to cause memory leaks in 
certain areas) 

6.18.19 and above OpenEdge 12.2 SP5 or later OpenEdge 12.5 SP 2 or later 

 

These Progress OpenEdge infrastructure requirements apply to both server and client machines.   

In each software release, Progress object code is supplied in two packs: a 5.18 pack (which is 
compatible with both 32bit and 64bit versions of OpenEdge 11.7), and 6.18 pack (which is 
compatible with both 32bit and 64bit versions of OpenEdge 12.2). The correct set of object code 
must be applied to the SOS AppServer for the version required, based on the Progress OpenEdge 
infrastructure installed on the server. 

SOS Connect client-side object code is supplied in two packs: C.18 32bit, and C.18 64bit.  Both 
versions of SOS Connect are compatible with server API versions 5.18 and 6.18.  We advise 
installing the SOS Connect pack with the same “bit-ness” (32bit/64bit) as the Microsoft Office 
installation on the client machine.  This will ensure better client-side integration with Microsoft Office. 
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Updated components in this release 

The following components and services have been updated in this release: 

Component Changed in this release 
(requires installation update) 

SOS Connect YES 

SOS Accounts (Practice Manager) YES 

Database view definitions YES 

Server-side email filing service YES 

Word Addin YES 

Outlook Addin YES 

Document attach service YES 

IManage integration YES 

Infotrack integration service YES 

SOS Connect customization YES 

Crystal Reports layouts YES 

Data Dictionary (HTML catalogue) NO 

SOS Connect Scripts YES 

EFT payment templates NO 

 
 

Changes to pre-requisites, compatibility and configuration 

There are no changes to pre-requisites, compatibility or configuration in this release.  For full details 
of pre-requisites, compatibility and configuration please refer to the accompanying document. 
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BREAKING CHANGES 

Changes to SOS scripts, existing software features and user access rights are described below. 

As normal, developers who are directly integrating to SOS API services should update their Proxy 
DLL references to the correct DLL file version when connecting to SOS systems running this latest 
patch update. 

 

Changes to existing software features 

The SOS Connect window layout and “docking” functionality now allows for an additional set of 
screen customization and layout changes to be saved specifically in the context of the Connect 
search screen. See issue number 16080 below for more information. 

Changes to SOS Scripts 

A change has been made to the standard SOS script User Preferences.sos to make use of a new 
setting as detailed in ticket number 15961 further down in this document. 

A pack of standard InfoTrack integration scripts has been incorporated into standard release (in 
folder \SOS\scripts\InfoTrack) for reference purposes, though most clients using InfoTrack 
integration will continue to hold their own “Firm” level version of these integration scripts. 

Changes to SOS Crystal Reports 

There is one fix to existing standard Crystal Report layouts in this release (see ticket number 16858 
below). 

Changes for API Integrators 

As part of the general update for compatibility with OpenEdge 11 and OpenEdge 12, any external 
integrators making direct use of the SOS server API by referencing the .Net Framework SOS Proxy 
libraries will need to update their application references as follows: 

DLL Reference Previous Version New Version 

sos_proxy.dll 4.18.18.11685 or 
5.18.18.11685 

0.18.19.12019 (this corresponds to visible 
Connect version C.18.19.12019) 

progress.o4glrt.dll 11.5.0.1190 12.2.51256.0 

progress.messages.dll 11.5.0.1190 12.2.51256.0 

 

Additionally, any .Net Framework projects which are updated to make use of the new reference 
libraries will also have to be migrated up to .Net Framework version 4.7.2. 

In terms of specific API service changes, there are no changes to existing services, but the following 
new services have been introduced: 
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Service Name Parameters Purpose 

Billing/ 
wmCalcFeesVATValues 

DSBILLCOSTALLOC (dataset input-output) Used during the standard private billing 
process, to calculate the VAT on fees 
including any correction to VAT rounding 
on specific cost lines to keep the overall 
fees NET and fees VAT values in line.  
Only applies when the fees in the bill are 
set to proportional calculation. 

Libraries/ 
wmGetServerInfo 

poServerVersion (string output) 
poVersionInfo (string output) 
poProgressVer (string output) 
poFirmsName (string output 

Returns server-side version and 
configuration information (used in the 
new SOS Connect version information 
window) 

Libraries/ 
wmGetSystemCOnfigDetails 

poInfo (string output) 
poRemoveServer (Boolean output) 

Returns extended server-side 
configuration (used in the new SOS 
Connect version information window) 

Libraries/ 
wmWebRequest 

piURL (string input) 
piMethod (string input) 
piContentType (string input) 
DSREQUESTHEADERS (dataset) 
piRequestStream (Progress MemPtr) 
poResponse (string output) 

Executes a generic web request to an 
external web resource, from the SOS 
server rather than the SOS Connect 
client application.  See issue number 
16931 for further details. 

 

 

Changes to User Access Rights 

There are no changes to user access rights in this release. 

 

Summary of bug fixes & minor changes 

This release contains a number of fixes and minor changes in both SOS Accounts and SOS 
Connect covering a variety of software areas.  Full details of the fixes and minor changes are 
provided at the end of this document. 

 

Updates in this release 

New and improved features in this release are detailed below.  The numbers in brackets after the 
headings are the internal SOS development ticket numbers that were used to track the software 
changes. 
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Changes to SOS Accounts 

Extension to option to run limited application features on server (16897) 

Further to the initial work which was included in the release of 4.18.18 and 5.18.18 under ticket 
number 16823 relating to a new option to run limited application features on a server, additional 
work has now been carried out to extend this option. 

The areas of SOS Accounts which have been added to this new option in this release include: - 

• Application start-up 

• Main Menu (Desktop) 

• Matter Enquiry – Details 

• Matter Enquiry – Actions 

• Matter Enquiry – Analysis 

• Matter Enquiry – Accounts Ledger 

• Matter Enquiry – Time Ledger 

• Matter Enquiry – Undertakings 

• Document displays in various areas 

• Selections lists used in reporting selection screens and other areas 

For further details on the initial work carried out, please refer to ticket number 16823 in the 4.18.18 
& 5.18.18 Release Notes (Revision 11636) document. 

 

Improved display of matter billing history (16651) 

A change has been made to the Billing History tab to make the columns wider as standard. The 
columns can also be widened further by the user. 
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Added ‘Credit Note Date’ merge field for credit note printing (16747)   

The standard template for credit notes has been enhanced to allow the use of a new document 
merge field specifically for the posting date of the credit note %[credit_note_date].  This should not 
be confused with the posting date of the bill, which remains unchanged as %[bill_date].  Use of this 
new merge field is not mandatory: it is at each firm’s discretion as to whether to include this new 
piece of documentation on the printed credit note or not.  The screen below shows a credit note 
document with this new merge field populated. 

 

 

 

Improved visibility of software version and system configuration information (17059) 

A change has been made to the information which is provided in SOS Accounts when you go to 
Help > System Settings.  The Version now shown will include the specific build number as well as 
the release number.  I.e 5.18.19.12019.  The bold and underlined number is the build number which 
is now included. 
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Changes to SOS Connect 

Enhanced "password" style widgets where value is hidden behind asterisks (15778) 

A change has been made to SOS Connect settings that have password fields (BigHand passwords, 
PostCode passwords, Telephony passwords, DocuSign and EchoSign passwords). When typing in 
your password it will now hide your characters with asterisks. This field will not allow the password 
to be copied and pasted. 

 

Improved performance when running InfoTrack queue-processing scripts (16955) 

Performance improvements have been made in the general job-request queue handling library, 
specifically to reduce the time taken to find the next incomplete job request for processing.  This 
performance improvement affects the InfoTrack queue handling process, EFT remittance 
generation service, SOS Document Attach service and document bundling service.   

A new utility is also included in this release (\sosobject\utilities\QueueClearDown.r) which can be 
used to export and delete historic queue request entries from the database which will also help to 
improve the performance of all services and functions that use the job queue.  The utility can be run 
while users are logged in, though we would recommend that it is run outside of normal operating 
hours as it may have an impact on general system performance when it is running.  The utility 
exports and removes historic completed job queue request entries into external flat data files which 
can be compressed and archived off-line if required for audit purposes. 

The export and deletion process is performed in monthly batches, with each month's worth of 
completed job queue entries exported into a separate file.  As such the utility is designed to be run 
no more frequently than once per month, or less frequently if the volume of completed job queue 
entries is not causing significant degradation in performance of the services using this data. 

In certain circumstances, depending on the distribution of data within the queue tables (specifically 
the QUEUE-REQUEST table), the time taken to retrieve data from the queue may still sometimes 
be unexpectedly slow: research done by SOS has shown that running a process on the database to 
refresh its internal data distribution statistics can increase the speed of data retrieval queries 
generally.  Any clients experiencing this issue should either use the utilities described above to 
reduce the historical contents of the queue tables or contact SOS for advice. 

 

Enhanced search screen docking panel layout (16080, 16352, 16992, 16993) 

An enhancement has been made to the SOS Connect Docking Panels function which was 
introduced in versions 4.18.10 and 5.18.10.  The enhancement in this release means that there are 
now five different types of screen which can be customised whereas previously there were only four.  
The five areas now available are: - 

• Main window (including Matters and other entities) 

• Search screen (This is new in this release) 

• Documents tab 
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• Script run (i.e. the Description/Subject window which cones up when creating a letter in SOS 
Connect) 

• Script Designer 

 

The Search screen in SOS Connect can now be customised in the same way as the other items 
listed above in relation to the same 5 panels: - 

• Top bar 

• Navigation panel (on the left) 

• Actions panel (on the right) 

• Bottom bar 

• Preview panel 

 

Navigation panel, Actions panel and Preview panel can be hidden / shown and expanded by 
dragging the sizing-border around. However, the SOS Connect screen can be switched between 
“Locked” mode (where only the sizes and visibility of these three panels can be changed) and 
“Unlocked” mode, where you can rearrange any of the panels listed above into any position and 
size you like. 

For full details of how the customisation of Docking Panels works in SOS Connect, please refer to 
the SOS Connect Docking Panel and Ribbon Bar document which accompanied the release of 
v4.18.10 and v5.18.10. 

 

Enhanced RunScriptFile Scripting Card (14676) 

A change has been made to the RunScriptFile scripting card as accessed from the Flow menu in 
SOS Connect Script Designer.  This change is to bring the usability of the card in line with the File > 
Open function.  The screen which comes up when you click on the ellipses (…) in the 
RunScriptFile scripting card is now the same as if you have clicked on File > Open from the top 
menu.  This change also makes the use of this card and the navigation of scripts easier for 
scripters. 
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Appearance in this new release 

 

 

Appearance in previous releases 
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Improved copying and pasting behaviour for email attachments (15803) 

A change has been made to the copy and paste function in SOS Connect when it comes to copying 
and pasting an attachment from an e-mail in Outlook to the Documents tab in an SOS Connect 
entity such as a Matter. 

In previous releases of the SOS Connect software, if you were copying and pasting an attachment 
from an e-mail in Outlook, when it came to pasting the item into SOS Connect you would have to 
use the keyboard shortcut of Ctrl + V as no paste option was visible under the right click > Edit 
menu.  In this release however, while you can still use the Ctrl + V option, if you right click in the 
Documents tab and go to Edit, you will also be shown the Paste option as per the below image: - 

 

 

Enhanced features in WebRequest scripting card (16931) 

The scripting card WebRequest has been enhanced, with three new input parameters: 

 

BasicAuthUser and BasicAuthPassword are optional new input parameters (both strings), and 
can be set to the required basic authentication parameters for specific web request calls as needed. 

SendRequestFromServer is a new Boolean (TRUE/FALSE) input parameter, with default value 
being FALSE.  This can be set to TRUE to send the web request from the server machine running 
the SOS API, rather than the client machine.  One intended use of this new feature is in the 
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integration between SOS and Perfect Portal (https://www.perfectportal.co.uk/).  The Perfect Portal 
API will only process requests from recognized “white listed” IP addresses, and in the context of 
SOS Connect being used remotely on a machine with a dynamic IP address (e.g. from home or 
generally away from the office) it is not possible to register the IP address of every SOS Connect 
client machine with Perfect Portal.  Registering the static public IP address of the SOS API server 
with Perfect Portal and switching this new input parameter to TRUE should resolve this problem. 

 

New Setting for Default FE Timesheet View (15961) 

A new setting has been added to the SOS Connect Settings screen (accessed via the SOS Connect 
icon in the PCs system tray) to select which tab you wish to have as your default view in the FE 
Timesheet. 

 

 

This new setting to enable you to default the above tab(s) can be found under Windows > 
Navigation in the Settings screen as shown below.  The new option is labelled Default tab selection 
on FE TimeSheet. 

 

 

  

https://www.perfectportal.co.uk/
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There are three options for this new setting, one for each of the available tabs in the FE Timesheet:- 

• Posted Items 

• All Completed Items 

• Day View 
 

Once you have made changes to the above setting and saved this via customisation, next time you 
go out and back into the FE Timesheet, the tab will default to the one you have set.  You can 
however still click between the three tabs as required. 

This same new setting has also been added to the User Preferences.sos script, as shown below: - 
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Sending Multiple Selected E-mails to Default Printer (9290, 13657, 15177) 

A change has been made in SOS Connect to allow a user to select multiple e-mails in the 
Documents tab of an entity such as a Matter and then send these to their default printer via a right 
click > Send To > Default Printer option.  Alternatively, the user can select the multiple e-mails in 
the Documents tab and then use the keyboard shortcut Ctrl + P to achieve the same, sending the 
selected items to their default printer. 

NB: The default printer is set from within Microsoft Windows itself, in the Printers & Scanners 
section of the Settings application.  SOS has no control over the setting of default printers. 

 

 

In addition to the above, e-mails can now be printed from SOS Connect without the need to have 
Microsoft Outlook installed on the PC.  To do this, select the e-mail(s) in question and either right 
click > Send To > Default Printer, or use the keyboard shortcut Ctrl + P.  This includes the above 
function of sending multiple e-mails for printing. 
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Changes to SOS Accounts and SOS Connect 

Added visibility of version and system configuration options (17092)  

SOS Accounts > Help > System Settings 

This part of the software has been extended to show System Settings and Options. It includes the 
following information regarding Clients System. 

• Firms Name 

• Client/Matter Coding Structure 

• Crystal Version 

• Activation Keys  

• Additional Packages/Options 

• System  

• Propath 

• Sessions Parameters 

• Sequences 

• SOSConfig.ini   

 

In SOS Connect, the information can be located in Version info. 
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For SOS Connect, functionality is available allowing the user to save Release info in a location 
using the Copy option  

 

 

 

Note that it’s only the Release info copied. (See Below) 

  

 

 

To have the all the Release info the User is able to use… 

  

This will allow the User to export the complete details to a text file via Notepad to a location of their 
choice.  
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VAT rounding errors in billing (14824) 

In previous releases when billing multiple fee earners’ time, with certain combinations of pence 
values in each individual fee value, it has been known to cause rounding differences when the VAT 
on each line is summarized and compared to the bill as a whole. For example, consider these 
unbilled time values on a private matter: 

 

If this time was billed as-is, the total net fees of £79.25 should attract a VAT value of £15.85, and 
(assuming the bill has no other content) the gross bill value should be £95.10.  However, in previous 
releases, because the VAT value for fees overall is calculated from the VAT element of each line, 
the total VAT value comes out at 2p short: 

 

In this scenario a warning message is also displayed, inviting the user to make minor manual 
adjustments to VAT values as required to bring the overall bill into exact balance: 
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In this release, when this scenario arises on private bills, the individual VAT values for each fee line 
will be adjusted automatically by 1p up or down until the overall correct VAT value is reached.  The 
warning message has also been removed.  The result in this case is that the two highest fees 
values are each adjusted up by 1p as shown below, resulting in the overall VAT total on fees being 
exactly correct: 

 

The exact logic for this change is as follows: 

• each fee earner cost VAT value is first calculated individually from the net value and VAT 
rate, rounded as before to nearest whole penny 

• the total VAT value is calculated to higher accuracy for the total net fees in the bill 

• the difference between the rounded detail VAT values and the total VAT overall is calculated 

• then 1p is systematically added or subtracted from each individual fee earner cost VAT 
value, from largest to smallest net value, then from first to last fee earner code, until all 
required adjustments have been made to bring the total VAT value in line with the total net 
value.   

By applying the adjustments to the highest net values first reduces the likelihood of extreme 
effective VAT rates appearing on each individual cost line.  In the example above, the effective VAT 
rate of the first entry is adjusted up from 19.98% to 20.03%, and on the second line from 19.98% to 
20.02%). 

This change of behaviour applies to private bill creation only (specifically when the proportional 
allocation method is enabled), and also to the Quick Bill function in both interfaces, and also to the 
manual entry of net fee values on the fees tab of the bill creation screen.  The change affects both 
SOS Accounts and SOS Connect 

 

 



Solicitors Own Software Limited (SOS)  Release Notes 

 

SOS Connect & SOS Accounts V5.18.19 & V6.18.19 Rev 12019  Page 25 of 36 

Changes to DocuSign 

Enable “transformPdfFields” DocuSign integration option (16881) 

 

 

PDF form field transformation enables you to transform PDF form fields automatically into DocuSign 
tabs, carrying over all of their existing values. The locations of the created tabs will match the 
locations of the fields from which they were generated. 

To transform PDF form fields into DocuSign tabs, you need to set the transformPdfFields property 
on the documents whose fields you want to transform. 
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Utilities 

Transfer Time (16885) 

A new utility DelFutureTimeAnaly.r has been added to the Utilities folder that can be used to 
delete All "Time" analysis from TRANALYSIS for records with a year greater than that entered. 
 

Utility to remove large number of redundant queue entries (17088) 

A new utility has been included in this release called QueueClearIncomplete.r (supplied in 
sosobject\utilties folder).  This new utility is locked down to SOS administrator use only.  It can be 
used to completely remove all entries in the SOS job queue tables (QUEUE-DATE and QUEUE-
REQUEST) for a specific queue entry type, in the scenario that a large number of entries exist in 
these tables for a specific queue entry type that are no longer required.  This utility should only be 
required if the existence of a large number of queue items is having a significant impact on the 
performance of the SOS system, where it is expected that removing these redundant items will 
return system performance back to normal. 
 

Enhancements to SOS Control Check utility (16832) 

The control checking utility ControlCheck.exe has been enhanced in this release, to include two 
additional sections of financial cross-checks relating to client bank postings and deposit bank 
postings.  These new sections are designed to pick up any anomalies in financial postings to client 
and deposit banks as soon as possible.  An example of these new sections is shown below: 

Client Banks 

Client Bank Balance Transaction Totals Balances Difference 

C001 £5,599,093.73 £5,599,093.73 £0.00 

Total £5,599,093.73 £5,599,093.73 £0.00 

Total Matter Client Balance - £5,589,300.10 -£9,793.63 

 
 

Deposit Banks 

Deposit Bank Balance Transaction Totals Balances Difference 

D226 £2,408.71 £2,408.71 £0.00 

D797 £2,201.29 £2,201.29 £0.00 

Total £4,610.00 £4,610.00 £0.00 

Total Matter Deposit Balance - £4,610.00 £0.00 

 

In each section, a list of transaction totals and financial balances are shown for each client and 
deposit bank, together with any differences between these two values.  The transaction total is 
calculated by adding the value of financial transactions (NOMTRANS) to the opening balance for 
the current branch year (NOMACCS.OPENING-BAL).  The balance value is taken from the closing 
balance for each bank nominal for the current branch year (NOMACCS.CLOSING-BAL).   

The last line of each section compares the total balance value for each type of bank with the 
equivalent account balance figure at matter level, again with any differences highlighted. 
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TrBalSet Enhancements and Improvements (16900) 

The SOS Admin’ utility TrBalSet has been enhanced in this release to include performance 
improvements.  This has been done by implementing classes which are used to accumulate 
analysis in memory with single updates to the database at the end of the process. 

As well as the performance improvements, you now have the ability to update selected matter 
headers and analysis by way of an input CSV file.  If this input CSV file is used, the process does 
not update time analysis in TrAnalysis. 

Full Build (as per previous versions) 
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Selected Matters From File 

 

 

The above screen shot shows where you navigate to your CSV input file.  All this CSV file has to 
contain is a matter code in the first column.  You can use the check box just below the highlighted 
field above to signify if you have a heading in your CSV or not (First Line Headers). 
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New utility to remove non primary / secondary phone and email records (16976) 

A new utility is included in this release called RemoveNonPrimTels.r and is located in 
…SOSObject\Utilities.  To run this utility from SOS Accounts (full view), go to File > Setup > 
Preferences > Utilities and navigate to the utility using the ellipses button ( … ) at the bottom right 
of the Utilities Menu screen.  Upon clicking Run Procedure, you will be shown the following screen 
to select what you wish to delete (Telephone Number / Fax Number / Mobile Number / Email 
Address).  Select the type of item you wish to delete and click Run. 

 

 

Upon clicking Run, you will be shown the following confirmation question.  To abort the process, 
simply click No.  However, if you wish to continue to run the deletion process, click Yes. 

 

 

At this point, any Telephone Number, Fax Number, Mobile Number or Email address (depending on 
your previous selection) which has not been marked as Primary or Secondary in the database will 
be deleted.  When the process is complete, you will see a confirmation message as shown below.  
Click OK to finish. 
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Resolved Issues & Minor Changes 

SOS Accounts & SOS Connect 

Software Area Description Ticket No(s) 

Solcase / VisualFiles Linking An issue was found with SOS Accounts and SOS Connect linked VisualFiles 
systems when creating a bill.  The following error could potentially appear on 
posting a bill. 

 

 

 

This issue has been resolved in this release. 

16964 

Data Access Groups A potential issue was found where a database could end up with two data 
access groups set as default within Data Access Groups maintenance.  This in 
turn would result in errors being encountered in the SOS software, for example 
no brokers available when accessing SOS Connect.  This potential issue has 
been resolved by doing the following: - 

 

1. In the SOS Accounts Data Access Group maintenance screen, if a 
data access group that currently isn't the default is amended and 
made the default, then fully commit all database updates before 
showing the warning message (this includes turning off the default 
flag on any other data access group) 

 

2. In standard library code that is returning the default data access 
group code to various SOS software areas, if a unique-find on the 
data access group marked as default fails with an "ambiguous" error, 
indicating that more than 1 data access group is marked as default, 
then attempt an automatic repair on the data to remove the default 
flag from all but one of the records. 

16937 
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SOS Accounts 

Software Area Description Ticket No(s) 

Posting Slips On a VisualFiles linked system if a posting slip has been created in VisualFiles 
and showing in SOS Accounts, then the Fee Earner deletes the posting slip 
before it gets posted in SOS Accounts, when it is viewed in SOS Accounts if 
the screen has not been refreshed a message will be displayed advising that 
this entry is not available. A refresh of the list will then remove the entry from 
the list. 

16963 

Crystal Reports SOS 
Standard - Inactive Matter 
Report 

An issue was found with the Inactive Matter Report if the Date Last Time 
Posting is empty it would shift columns Date last accounts posting, date list 
client posting, Date last correspondence data to the left. This issue has been 
resolved in this release. 

16858 

Crystal Reports SOS 
Standard – Unbilled AD 
Report 

Reports > Monthly > Unbilled AD Report.  This report was failing to include AD 
transactions when the Supplier Contra Code included a defined AD Contra 
Code in Maintenance > Supplier.    

 

 

 

This fault occurred when an additional control nominal was introduced on 
Supplier Details. To rectify this problem our developers ensured that all 
unbilled ADs are included in the Unbilled AD Report regardless of the Contra 
Code that any ADs have been posted with.  This issue has now been resolved.   

16906 

Organisation Enquiry / ID 
tab of Contact  

PM > Contact Management >Search > Individual radio Button, bring up contact 
details of individual > Identification tab.  Navigation and recording of data failed 
to work correctly.   

 

This issue relates to 32k reporting amendments in previous Project. This area 
was missed and therefore required to have the same type of amendments 
applied which has now been implemented in this release.  

16961 

Suppliers When paying multiple invoices for a supplier using EFT if the invoices being 
paid had the same references these would not show in the EFT print and 
Export options. This has been resolved in the release. 

16833 

Posting Slips An issue was found that if a user had been deleted from the user table when 
viewing the Posting Slips that User would remain in the list of available Users 
to choose from. This would cause an error to occur. This issue has been 
resolved by removing the User from the available list in the Posting Slip screen 
when a user has been removed from the User table. 

16960 

Settings An issue was found that if the setting “Prevent users from logging in” was set 
when using the SSO (Single Sign On) users could continue to log in. This 
issue has been resolved in this Release. 

16925 

rpAnalMatOpenedByDate.r A change has been made to the rpAnalMatOpenedByDate.r to the branch 
filtering. The 32K limit has been applied to the branch selections to improve 
returned results. 

17022 

rpcontmat.r A change has been made to the rpcontmat.r to the branch filtering. The 32K 
limit has been applied to the branch selections to improve returned results. 

17023 

LA Wip Billed  A change has been made to the RPLAWIPW.r to the branch, fee earner and 
matter type filtering. The 32K limit has been applied to the selections to 
improve returned results. 

17025 
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Software Area Description Ticket No(s) 

RPSupplierInvoicesPaid.r A change has been made to the RPSupplierInvoicesPaid.r to the branch 
filtering. The 32K limit has been applied to the branch selections to improve 
returned results. 

17027 

Undertakings A change has been made to the rpundertakings.r to the Fee Earners selections 
The 32K limit has been applied to the Fee Earner selections to improve 
returned results. 

17028 

Reporting A change has been made to the FE View > FE Desktop > Graphs to the 
branch selections The 32K limit has been applied to the branch selections to 
improve returned results. 

17030 

Copy / Cut and Pasta in 
Docs Tab 

An issue was found with the Copy / Cut and Paste function within the 
documents tab of SOS Accounts where a message would show to say Copy 
Cancelled.  This issue has been resolved in this release. 

16908, 16941, 
16958, 17099, 
17123 

Posting Slips  Branch selection issues occurred, which resulted in expected data absent from 
the Posting Slip screen in SOS Accounts.  The 32K limit has been applied to 
the Branch selections to make sure that data is returned accurately.   

17031 

Custom Report  The 32K limit has been applied to Branch Selection on Reports, which has 
resulted in the correct data being returned. 

17032 

SOS Accounts /Ledger/ 
Delete  

In Release X.18.18 the Delete Option in the Matter Ledger (tab) screen was 
constantly enabled which allowed the deletion of Matters regardless of the 
criteria for deleting a Matter (ie No time, or value should be outstanding against 
a matter.)  The functionality has now returned in this Release and is working as 
expected.  

17076 

Legal Aid Billing  When updating an LA Memo Bill Payment to ‘undo’ a zero paid payment an 
error message would be displayed.  This has now been corrected and working 
as expected allowing the ‘undo’ of a zero transaction. 

 

16827 

Nominal Budget Load A change has been made to the Nominal Budget Load to the Branch 
selections The 32K limit has been applied to the Branch selections to improve 
returned results. 

17021 

Autobank Rec  The import for the Auto Bank Reconciliation Yorkshire 2 format has been 
amended so that it is compatible with additional bank formats e.g. Virgin. The 
format is fundamentally the same, the only change is to not reverse the sign of 
the value of a statement item if the value is already negative which denotes a 
debit.  

Previously, the value was reversed if the type was marked as DR meaning that 
if the sign is already negative (debit) then it would become positive thus 
resulting in a credit when imported.  

If the value of the item is positive and the type is DR then the value will 
continue to be reversed so as to continue to support existing implementations 
of the format. 

17058 

Bank Reconciliation A change has been made to the Report Bank Reconciliation to the Branch 
selections The 32K limit has been applied to the Branch selections to improve 
returned results. 

17034 

Database View Definition for 
A.COSTPAIDDATA 

The database view definition for A.COSTPAIDDATA has been amended in this 
release, to resolve two separate issues.   

The original view definition contained a fault which was only apparent on 
certain types of transactional data content, where multiple payment reversals 
(caused by a single UAC posting) containing duplicated values for payment net 
and VAT values caused one or more of the payment reversal transactions to 
be omitted from the data returned by the view.  The consequence of this was 
to show incorrect payment reversal values in any queries based on this data 
view for certain patterns of transactional data.  This problem has now been 
resolved. 

In addition, the data base view was not including costs paid information 
relating to “cost paid adjustment” bills.  This issue has also been resolved. 

17075, 17106 
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Software Area Description Ticket No(s) 

Analysis Budget Load In versions x.18.18 and x.18.18 patch 2, an issue was found with the Analysis 
Budget Load screen located under File > Setup > Balance Loading in SOS 
Accounts.  When users were using this screen to enter budgets, for example 
as set out in the screen shot below, when the Apply button was pressed, no 
confirmation message was appearing (as shown in the green box below).  If 
users also went out of the screen and then back in to view exactly the same 
budget load, the previously entered figures were not showing and each field 
remained as 0.00.  A change has now been made to rectify these issues and 
return the screen functionality to what it was in x.18.17.  The confirmation 
message shown in the green box below now displays, and any previously 
entered figures are shown if they exist for the selections made at the top of the 
screen. 

 

 

 

17083 
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Software Area Description Ticket No(s) 

Analysis Budget Load Also in the Analysis Budget Load screen, an issue was found where the 
Annual Budget field would remain greyed out and you would not be able to 
enter any data into it even when your selections at the top of the screen should 
allow you to do so. 

 

 

 

This issue has now been resolved and the Annual Budget field will now be 
available for editing when appropriate. 

 

 

17121 

Matters – Joint(Accounts + 
Time) 

A change has been made to the Matters – Joint(Accounts + Time) to the Client 
account selections The 32K limit has been applied to the Client account 
selections to improve returned results. 

17026 

Chart of Accounts An issue was found with the treeview that if you create a new folder and give it 
a name which is the same as an existing Nominal Code, the new folder would 
overwrite the existing Nominal Code and cause the Trial Balance to go out of 
balance. This issue has been resolved in this release. 

17097 

Costs Paid Report The standard costs paid report was correctly showing “costs paid adjustment” 
bills when it was run in date range mode, but these were not being shown on 
the report if run in year/period mode.  This fault has been fixed. 

17106 

Report Sets An issue was found when using the Report Sets screen in SOS Accounts 
when selecting any report which is held in a sub folder.  Errors would be 
encountered when attempting to add the said report to the list.  This issue has 
now been resolved and the Report Sets screen functions as expected for 
reports both not in a subfolder and in a subfolder. 

17053 

Time Bills Screen An issue was found when multi-posting Controlled or Criminal Matter bills via 
the Time Bills Enquiry screen. If you lost your connection to the App Server the 
postings would remain in the Time Bills Enquiry screen and the matters would 
be locked, which would need to be cleared via softlocks. This issue has been 
resolved in this release. 

17070 
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SOS Connect 

Software Area Description Ticket No(s) 

Suppliers When viewing the Posting Slip queue for previously created SP postings to 
update any entries that have been marked as delete will no longer be shown. 

A previously applied block on deletion on SP posting slip queue entries has 
been reversed so that entries can be marked as deleted. 

If you pencil an AD then post it in SOS Connect then pay it in SOS Connect to 
create a SP posting slip, then undo the accounts ledger entry in SOS Accounts 
this would leave a SP entry in the posting slip queue. The AD would be 
changed back to a pencilled state but would not allow the entry to be 
processed again, due to the pay flag still remaining. This issue has been 
resolved in this release. 

If an existing SP posting slip exists for a matter the posting date and cashier’s 
notes could incorrectly get updated when other Ads are being added. This 
issue has been resolved in this release. 

16938 

VAT Report The SOS Accounts VAT Return screen has been enhanced.  When printing 
detail/summary reports from this screen, changes have been made to ensure 
that any posting narratives containing carriage return characters entered via 
SOS Connect will not cause the full details of the transaction to be omitted 
from the reports. 

16944 

Ledger – Transferable Total  A bug was found in the calculation of the Transferable Total on the ledger 
screen.  An Allocation of Credit is posted with VAT amended to Zero on a ADV 
posting.  The transferable total was ingnoring the VAT on the ADV Posting and 
therefore falling short of the total of Transferable Value.  This issue has now 
been resolved by making sure that the VAT is not ignored and included in the 
total.   

16891, 15728, 
15714, 13829, 
11502, 9899, 
9831 

iManage Integration Code 
Missing 

In X.18.18 and X.18.18Patch2, two required files were missing from the 
iManageREST folder supplied in the Connect TAR file.  With these files 
missing, errors were shown in any Connect scripts making use of iManage 
integration.  The missing files have now been included. 

17071 

EchoSign API  Following the update to 5.18.14 to accommodate for changes at Adobe Sign, 
when Client runs a script to retrieve a document (using 
EchoSignDocumentGetLatest card), the document returned is password 
locked. However, when opening the same file on Adobe's website, there is no 
password required.  This has only started occurring since the change from 
using the EchoSign API to Adobe Sign v6 API. 

This issue has now been resolved, and .pdf documents can be accessed via 
Connect without the restriction of passwords which mirrors functionality that 
Adobe websites implements.     

16694 
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SOS Utilities 

Software Area Description Ticket No(s) 

Dump Load An issue was found with the Dump Load Utility and the QUEUE-REQUEST 
database table. When you export data from this table the data type DATETIME 
was not being exported correctly. When you tried to reload the data it would 
produce an error. This issue has been resolved in the release. 

16990 

NomtransCodeAmend.r A change has been made to the NomtransCodeAmend.r utility to the branch 
filtering. The 32K limit has been applied to the branch selections to improve 
returned results. 

17015 

SupplierControlPostings.r A change has been made to the SupplierControlPostings.r utility to the branch 
filtering. The 32K limit has been applied to the branch selections to improve 
returned results. 

17016 

CashflowExport.r A change has been made to the CashflowExport.r utility to the branch filtering. 
The 32K limit has been applied to the branch selections to improve returned 
results. 

17019 

UTJTUUndone.r A change has been made to the UTJTUUndone.r utility to the branch filtering. 
The 32K limit has been applied to the branch selections to improve returned 
results. 

17018 

GlobalMTAmend.r A change has been made to the GlobalMTAmend.r utility to the branch 
filtering. The 32K limit has been applied to the branch selections to improve 
returned results. 

17020 

Rpundertakings.r A change has been made to the Rpundertakings.r utility to the branch filtering. 
The 32K limit has been applied to the branch selections to improve returned 
results. 

17036 

UTADUnBilled.r A change has been made to the UTADUnBilled.r to the branch selections The 
32K limit has been applied to the branch selections to improve returned results 

17029 

UTHistoryZoneTilde.r The utility UTHistoryZoneTilde.r (supplied in the utility folder) was modified in a 
previous version to cater for unacceptable open-curly-bracket symbols in 
Connect virtual document folder names.  When this change was made, a fault 
was introduced in the original behaviour of this utility to remove unacceptable 
tilde (~) characters from folder names.  This problem has now been resolved, 
and both tilde characters and open-curly-bracket characters are now correctly 
replaced with an alternative acceptable character as selected on the utility 
screen. 

17049 

 

 


